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Stellar Phoenix PowerPoint Recovery 
 

Overview 

Stellar Phoenix PowerPoint Recovery is designed to recover corrupted Microsoft PowerPoint 
(.ppt\.pptx) files. This software scans all PowerPoint files and uses an advanced algorithm to 
restore PowerPoint files back to their original state. The recovered files can either be saved to 
their original location on the hard disk, or to any user-specified location. 

You can preview the PowerPoint files before saving to a location. You can search for PowerPoint 
files in folders and drives. You can save all or individual files. In addition, you can save files to 
original location or specific location. 

Key Features of Stellar Phoenix PowerPoint Recovery 

• Recovers Powerpoint files with all formatting and attributes 

• Recovers PowerPoint files same as original 

• Preserves everything when restoring files 

• Supports MS PowerPoint 2000, XP(2002), 2003 and 2007 

• Compatible with 2000/ XP/ 2003/ Vista 
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Stellar Phoenix PowerPoint Recovery 

 

Getting Started 

Stellar Phoenix PowerPoint Recovery software provides you preview, search and recover options 
for performing recovery of PowerPoint files. The user interface of PowerPoint Recovery software 
is easy to use and anyone can use it without any technical knowledge. You can start recovering 
Microsoft PowerPoint files after installing the PowerPoint Recovery software. 

• Installing PowerPoint Recovery software 

• Order and Register 

• Main User Interface 

• Toolbar 

• Menubar 
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Installation Procedure 

Before installing the software, ensure that your computer meets the minimum system 
requirements to install Stellar Phoenix PowerPoint Recovery software. 

• Minimum System Requirements 

Processor :Pentium Class 

Operating System: Windows NT / 2000 / XP / Vista 

Memory :128 MB recommended 

Hard Disk :10 MB of free space 

MS PowerPoint: 2000 / 2002 (XP) / 2003 / 2007 

To install the software: 

1. Double-click spppr.exe file to open the Stellar Phoenix PowerPoint Recovery Setup 
Wizard. Click Next. 

2. On the Specify Destination Location screen, specify the destination where Stellar 
Phoenix PowerPoint Recovery software should be installed. Click Next. 

3. On the Select Start Menu Folder screen, specify the destination where program shortcuts 
should be stored. Click Next. 

4. On the Select Additional Tasks screen, check the checkboxes of required icons. Click 
Next. 

5. On the Ready to Install screen, click Install. 

6. Click Finish to exit setup wizard. 
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Order and Register 

You can purchase the software online. For price details and to place the order, click here. 

On confirmation of order, a pre-paid serial number is sent to you through e-mail that would be 
required to register the software. 

Register Stellar Phoenix PowerPoint Recovery: 

After receiving the Registration Key, the software can be activated. 

To register the software: 

• Method 1 

1. Click Enter Key button on the reminder window. 

2. Type the name and key (received through e-mail after purchase). 

3. Confirmation message pops up, if the key is valid, click OK. 

• Method 2 

1. Run demo version. 

2. On the Tools menu, Click Activate. 

3. Type Name and Key. Click OK. 

Help Manual Version 1.0.0.0 
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User Interface 

The main user interface of Stellar Phoenix PowerPoint Recovery is as shown below. 
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Toolbar 

Toolbar of Stellar Phoenix PowerPoint Recovery consists of the given below tools: 

• Add file to tree view 

  

Opens Stellar Phoenix PowerPoint box, which allows you to select Microsoft PowerPoint files from 
folders and volumes. In addition, you can search files by using this dialog box. 

• Remove File(s) /Folder(s) from tree view 

 

Removes checked file from the tree, if no file is checked then all files are removed on clicking this 
icon 

• Start Repair 

 

Starts recovering files 

• Stop 

 

Stops an ongoing repairing process 

• Stellar Phoenix PowerPoint Recovery Help 
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Opens help manual of the software 

• Updates 

 

Download latest updates of the software 

• Purchase 

 

Shows links from where you can buy the software   

• About Stellar Phoenix PowerPoint Recovery 

 

Shows general information about the software 
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Menubar 

These are the menus and items in the Stellar Phoenix PowerPoint Recovery software. 

• File 

o Add File(s) to Tree View: to add PowerPoint files to the tree view 

o Remove File(s) from Tree: to remove selected files from the tree view 

o Start Repair: to start the repairing process 

o Stop: stop a process 

o Exit: to quit the application 

• View 

o Toolbar: Show/Hide the toolbar 

o Status bar: Show/Hide the Status bar 

o Message bar: Show/Hide the Message bar 

• Tools 

o Save Log: To save the log information 

o Clear Log: To clear the log information 

o Raw Recovery: Recovers selected files 

• Help 

o Stellar Phoenix PowerPoint Recovery help: Opens the user guide 

o Purchase Stellar Phoenix PowerPoint Recovery Online: Purchase details of the 
product 

o Activate Stellar Phoenix PowerPoint Recovery: Purchase details of the product 

o View support section: Opens Stellar support section webpage 

o Visit knowledge base: Opens knowledge base article webpage 
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o Submit support ticket: Opens the login page, to submit ticket 

o Updates: To open update wizard for live updates 

o About Stellar Phoenix PowerPoint Recovery: Generic information about the product 
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Using the Software 

Stellar Phoenix PowerPoint Recovery software repairs and restores MS PowerPoint files 
corrupted due to virus attack, software malfunctioning or unexpected system shut down. It can 
recover single or individual PowerPoint files. 

• Repairing PowerPoint files 

• Adding files 

• Searching files 

• Viewing preview 

• Viewing log 



Stellar Phoenix PowerPoint Recovery 

12 

 

Stellar Phoenix PowerPoint Recovery 
 

Repairing PowerPoint Files 

Stellar Phoenix PowerPoint Recovery recovers Microsoft PowerPoint files and allows you to save 
files to your preferred location. You can recover individual or multiple files by using PowerPoint 
Recovery. 

To recover Microsoft PowerPoint files: 

1. Click  icon or on the File menu, select Add file to tree view. 

2. In the Stellar Phoenix PowerPoint Recovery box, add files by using one of the following: 

• Select individual file 

o Click Select File. In the Open dialog box, locate and select the 
PowerPoint file. Click Open, and then click Add. 

• Select multiple files 

1. Click Select Folder. In the Browse for Folder dialog box, browse and 
select the required Folder. You can also select a volume. Select folder or 
volume. Click OK, and then click Add.  

2. In the Stellar Phoenix PowerPoint Recovery dialog box, all files that are 
found in the selected folder or drive are listed. Check the checkboxes of 
files that needs to be recovered. Click Add. All files will be listed in the 
left pane under Stellar Phoenix PowerPoint Recovery node. 

• Search files 

o Click Search File(s). In the Select Drive box, select a drive from Look in 
listbox. Click Start. All files that are found are listed in the Stellar Phoenix 
PowerPoint Recovery box. In addition, you can search in folder, click 
Search in Folder. In the Browse for Folder dialog box, locate and select 
a folder. You can also specify a drive. Select a folder or volume. Click 
OK. Check Search in Subfolders checkbox if you want to search files 
inside the subfolders also. Click Start. All files that are found are listed in 
the Stellar Phoenix PowerPoint Recovery box. Check the checkboxes of 
files that needs to be recovered and click Add. 

3. All selected files are listed in the left pane. Check the checkboxes of files that needs to be 

recovered. Click  icon or on File menu, select Start repair. In the Save Document 
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dialog box, select Default location of file or Select New Folder. Former will save the file 
to its original location from where it is added. Latter allows you to specify new destination. 
In addition, you can select Raw Recovery from the Tools menu to recover all files listed 
in the tree. 

4. Click OK. All selected files are saved at the specified location. 

Note: You cannot recover .pptx files by using Raw Recovery feature of Stellar 
Phoenix PowerPoint Recovery. 



Stellar Phoenix PowerPoint Recovery 

14 

Stellar Phoenix PowerPoint Recovery 
 

Adding Files 

You can add individual files or multiple files in the PowerPoint Recovery software. In addition, you 
can specify a folder or a volume as a folder such that all PowerPoint files can be added from that 
folder. 

To add individual file: 

1. Click  icon on the toolbar, or on File menu, select Add File to Tree View. 

2. In the Stellar Phoenix PowerPoint Recovery dialog box, click Select File.  

3. In the Open dialog box, locate and select the required PowerPoint file. Click Open, and 
then click Add. 

To add multiple files: 

1. Click  icon on the toolbar, or on File menu, select Add File to Tree View. 

2. In the Stellar Phoenix PowerPoint Recovery dialog box, click Select Folder.  

3. In the Browse for Folder dialog box, browse and select the required Folder. You can also 
select a volume. Select folder or volume. Click OK, and then click Add. 

4. In the Stellar Phoenix PowerPoint Recovery dialog box, all files that are found in the 
selected folder or volume are listed. Check the checkboxes of files that needs to be 
recovered. Click Add. All files will be listed in the left pane under Stellar Phoenix 
PowerPoint Recovery node. 
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Searching Files 

You can search for Microsoft PowerPoint files in your computer by using search option of the 
software. In case, you are unaware of the exact location of required file you can search the file 
easily. 

To search files from drive: 

1. Click  icon. In the Stellar Phoenix PowerPoint Recovery dialog box, click Search 
File(s). 

2. In the Select Drive box, select a drive from Look in listbox. Click Start. All files that are 
found are listed in the Stellar Phoenix PowerPoint Recovery box. 

To search files from folder: 

1. Click  icon. In the Stellar Phoenix PowerPoint Recovery dialog box, click Search 
File(s). 

2. In the Select Drive box, click Search in Folder. 

3. In the Browse for Folder dialog box, locate and select a folder. You can also specify a 
drive. Select a folder or volume. Click OK. Check Search in Subfolders checkbox if you 
want to search files inside the subfolders also. 

4. Click Start. All files that are found are listed in the Stellar Phoenix PowerPoint Recovery 
box. 
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Viewing Preview 

Stellar Phoenix PowerPoint Recovery shows preview of corrupted PowerPoint files that helps you 
to evaluate files before repairing. If you want to preview a file, click on the required file in the tree 
view. 

To preview the file: 

• Click on a file in the left pane 
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Removing Files 

You can remove files from the Stellar Phoenix PowerPoint Recovery node. If some files are 
added that are not required then you can remove these files without exiting the PowerPoint 
Recovery software. 

To remove files: 

1. Check the checkboxes of file that needs to be removed. 

2. Click  icon from toolbar or on the File menu, select Remove from Tree. All 
selected files will be removed. 

Note: By default, all files are checked when you add files in the tree. If you click 
Remove files from tree icon all files will be removed. Therefore, ensure that you 
checked or cleared the checkboxes of required file. 
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Log Report 

Log window shows the progress of the current process. The log window displays messages such 
as indicating the beginning of the process, end of the process, name of the corrupted file. 

• To enable log window 

o On the View menu, select Message log 

• To save log information 

o On the Tools menu, select Save Log. In the Save As dialog box, specify the 
destination where log file should be saved. Click Save. 

• To clear log information 

o On the Tools menu, select Clear Log. 
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Copyright 

Stellar Phoenix PowerPoint Recovery software, accompanied user manual and documentation 
are copyright of Stellar Information Systems Ltd., with all rights reserved. Under the copyright 
laws, this user manual cannot be reproduced in any form without the prior written permission of 
Stellar Information Systems Ltd. No Patent Liability is assumed, however, with respect to the use 
of the information contained herein. 

Copyright © 1995-2009 by Stellar Information Systems Ltd. INDIA 
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Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, 
is subject to change without notice. 

STELLAR INFORMATION SYSTEMS LTD PROVIDES NO WARRANTY WITH REGARD TO 
THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY 
EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR 
FITNESS FOR ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING 
STELLAR INFORMATION SYSTEMS LTD ASSUMES NO LIABILITY FOR ANY DAMAGES 
INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL 
ERRORS OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE 
PRODUCT AND THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION SYSTEMS 
LTD, BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY 
DAMAGES, WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF 
OR IN CONNECTION WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED 
HEREIN OR THE USE THEREOF. 
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Trademarks 

Stellar Phoenix PowerPoint Recovery® is a registered trademark of Stellar Information Systems 
Ltd. 

Windows 2000®, 2003®, XP® and Windows Vista® are registered trademarks of Microsoft® 
Corporation Inc. 

All Trademarks Acknowledged. 

All other brands and product names are trademarks or registered trademarks of their respective 
companies. 
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License Agreement 

Stellar Phoenix PowerPoint Recovery 

Copyright © 1995-2009 by Stellar Information Systems Ltd. INDIA 

www.stellarinfo.com 

All rights reserved. 

All product names mentioned herein are the trademarks of their respective owners. 

This license applies to the standard-licensed version of Stellar Phoenix PowerPoint Recovery. 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing 
this software, unless you have a different license agreement signed by Stellar Information 
Systems Ltd. 

If you do not agree to all of the terms and conditions of this License then do not copy, install, 
distribute or use any copy of Stellar Phoenix PowerPoint Recovery with which this License is 
included, you may return the complete package unused without requesting an activation key 
within 30 days after purchase for a full refund of your payment. 

The terms and conditions of this License describe the permitted use and users of each Licensed 
Copy of Stellar Phoenix PowerPoint Recovery. For purposes of this License, if you have a valid 
single-user license, you have the right to use a single Licensed Copy of Stellar Phoenix 
PowerPoint Recovery. If you or your organization has a valid multi-user license, then you or your 
organization has the right to use up to a number of Licensed Copies of Stellar Phoenix 
PowerPoint Recovery equal to the number of copies indicated in the documents issued by Stellar 
when granting the license. 

Scope of License 

Each Licensed Copy of Stellar Phoenix PowerPoint Recovery may either be used by a single 
person or used non-simultaneously by multiple people who use the software personally installed 
on a single workstation. This is not a concurrent use license. 

All rights of any kind in Stellar Phoenix PowerPoint Recovery, which are not expressly granted in 
this license, are entirely and exclusively reserved to and by Stellar Information Systems Ltd. You 
may not rent, lease, modify, translate, reverse engineer, decompile, disassemble or create 
derivative works based on Stellar Phoenix PowerPoint Recovery nor permit anyone else to do so. 
You may not make access to Stellar Phoenix PowerPoint Recovery available to others in 
connection with a service bureau, application service provider or similar business nor permit 
anyone else to do so. 
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Warranty Disclaimers and Liability Limitations. 

Stellar Phoenix PowerPoint Recovery and all accompanying software, files, data and materials 
are distributed and provided AS IS and with no warranties of any kind, whether expressed or 
implied. In particular, there is no warranty for the quality of data recovered. You acknowledge that 
good data processing procedure dictates that any program including Stellar Phoenix PowerPoint 
Recovery must be thoroughly tested with non-critical data before there is any reliance on it and 
you hereby assume the entire risk of all use of the copies of Stellar Phoenix PowerPoint 
Recovery covered by this License. This disclaimer of warranty constitutes an essential part of this 
License. 

In addition, in no event does Stellar authorize you or anyone else to use Stellar Phoenix 
PowerPoint Recovery in applications or systems where its failure to perform can reasonably be 
expected to result in a significant physical injury or in loss of life. Any such use is entirely at your 
own risk and you agree to hold Stellar harmless from any and all claims or losses relating to such 
unauthorized use. 

General 

This License is the complete statement of the agreement between the parties on the subject 
matter and merges and supersedes all other or prior understandings, purchase orders, 
agreements and arrangements. This License shall be governed by the laws of the State of Delhi, 
India. Exclusive jurisdiction and venue for all matters relating to this License shall be in courts and 
for a located in the State of Delhi, India and you consent to such jurisdiction and venue. There are 
no third party beneficiaries of any promises, obligations or representations made by Stellar 
herein. Any waiver by Stellar of any violation of this License by you shall not constitute nor 
contribute to a waiver by Stellar of any other or future violation of the same provision or any other 
provision of this License. 

Copyright ©1995-2009 by Stellar Information Systems Ltd. All rights reserved. 
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Technical Support 

Our Technical Support professionals will give solutions of all your queries related to Stellar 
Products. 

You can either Call Us or Go Online to our support section 
http://stellarinfo.com/esupport/users/kb.php 

Support Helpline 

Monday – Friday [ 24 Hrs. a day ] 

USA (Toll free - Pre Sales Queries)  1-866-554-2512 

USA (Post Sales Queries) 1-315-220-6245 

UK (Europe) +44-207-993-2293 

Germany +49-180-110-105-0051 

Worldwide +91-921-395-5509 

Skype Id stellarsupport 

Email Order orders@stellarinfo.com 

Online Help 

 Chat Live with an Online technician 

 Search in our extensive Knowledge Base 

 Submit Ticket (If our Knowledge Base does not answer your question) 
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 Login and view Ticket Status (If you already have a valid Ticket with you) 

 Download Documents on Product Usage ( For Registered members only, i.e, user with 
login ID. If you are an unregistered user, please visit 
http://stellarinfo.com/esupport/users/login.php to create login ID) 
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About Stellar 

Stellar Information Systems Ltd. is a trusted name in the field of Data Recovery and Data 
Protection Software for more than a decade. 

We provide the widest range of Data Recovery Products. Our range includes Data Recovery 
Software for almost all Operating Systems and File Systems. 

Product line: 

Data Recovery 

A widest range of data recovery software that helps you recover your valued data lost after 
accidental format, virus problems, software malfunction, file/directory deletion, or even sabotage!. 
More Info >> 

File Recovery 

The most comprehensive range of file undelete and unerase software for Windows and MS office 
repair tools. More Info >> 

Email Recovery 

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS 
Outlook Express and MS Exchange useful in instances of data loss due to damages and 
corruption of Email. More Info >> 

Data Protection 

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to 
ensure complete data protection against hard drive crash. More Info >> 

Data Sanitization 

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical 
drives, System Traces & Internet traces. Once the data have been removed using Stellar Wipe - 
Data File eraser utility, it is beyond recovery limits of any Data Recovery Software or utility. More 
Info >> 

For more information about us, please visit www.stellarinfo.com 
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